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Lesson Objectives 
 

 To discuss decisions that must be made before using QuickBooks 
 

 To create a new QuickBooks company using the EasyStep Interview 
 
 To set QuickBooks preferences in the Interview 

 
 To record the opening balance for a checking account 

 
 To enter customers, jobs, vendors, accounts, and items 

 
 To practice using the QuickBooks Help tools 

 

Notes 
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Creating a QuickBooks Company 
 
A QuickBooks company contains all the financial records for a single business. Before you 
can use QuickBooks, you need to tell QuickBooks about your business so that it can set up 
your company file.  
 

 EasyStep Interview walks you through setting up your business: 
 

o Company Information 
o Chart of accounts based on your industry 
o Company organization 
o Sales information 
o Sales tax information 
o Estimates 
o Sales receipts 
o Preferences 
o Business start date 
o Creating an account and entering the opening balance 
o Reviewing the chart of accounts 
o Completing company file setup 

 

Notes 
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Starting the EasyStep Interview 
 
To begin adding a new company: 
 

1. Start QuickBooks. 

2. Select Create a new company or choose New Company from the File menu. 
QuickBooks displays the EasyStep Interview window. 

 

 
 

Notes 
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Entering Company Information 
 
To create a new QuickBooks company file: 
 

1. At the Welcome window for the interview, click Start Interview to begin. 

2. In the Company Name field, type Lockhart Design and press Tab. 

3. Press Tab again and type 94-1234567 as the Tax ID number.  

 
Notes 
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Entering Company Information 
 

4. Type the following information in the Street address, City, State, and Zip fields: 

1239 Bayshore Road 
Middlefield, CA 94432 

 
5. Now enter the following information in the Phone and Fax fields: 

Phone: 650-555-1234 
Fax: 650-555-5678 
 

6. Next enter the email and Web addresses for Lockhart Design. 

Email: margaret@samplename.com
Web site: lockhart_design@samplename.com
 

 
7. Click Next. 

 

Notes 
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Using a Preset Chart of Accounts 
 
To choose your company industry to create a chart of accounts: 
 

1. In the “Select your industry” window, scroll down the list and select Retail Shop or 
Online Commerce from the industry list. 

 

 
 

2. Click Next. 

 

Notes 
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Selecting How Your Company Is Organized 
 
To select your company organization:  

1. Click Sole Proprietorship to select it. 

2. Click Next.  

QuickBooks needs to know the starting month of your fiscal year. 

3. Since Lockhart Design’s fiscal year started in January, leave January selected and 
click Next. 

4. In the Set up administrator password window, click Next.  

5. Click Next to save the company file. 

6. Make sure that QuickBooks is set to save the file in the QBTrain folder you set up in 
the first lesson. 

7. In the “Filename for New Company” window, select Save to accept the default 
filename of “Lockhart Design.” 

 
Notes 
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Indicating What You Sell 
 
You need to indicate what your business sells. In general, businesses either sell products or 
services, or both. Margaret Lockhart provides consulting services as well as selling products, 
such as fabrics. 
 
To indicate what you sell: 
 

1. Click Next in the “Customizing QuickBooks for your business” window. 

2. On the “What do you sell?” window, click Both services and products. 

 

 
 

3. Click Next. 

 
Notes 
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Entering Sales Information 
 
For retail companies, you need to indicate how you want to enter sales. QuickBooks uses this 
information to set recommendations for a retail-type business. Margaret Lockhart does not do 
retail sales on a daily basis, so she will record her sales as they occur. 
 
To indicate how you enter sales: 
 

1. On the “How will you enter your sales in QuickBooks?” window, click Record each 
sale individually. 

 

 
 

2. Click Next. 

3. On the “Do you sell products online?” window, click I don’t sell online and I am 
not interested in doing so. 

 

Notes 
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Entering Sales Tax Information 
 
You should turn the sales tax setting off only if you never charge sales tax. Margaret Lockhart 
typically charges sales tax, so we’ll turn on sales tax in her company file. 
 
To setup QuickBooks to track sales tax: 
 

1. Click Next to move to the “Do you charge sales tax?” window. 

2. Click Yes for the question, “Do you charge sales tax?” Then click Next. 

QuickBooks automatically creates a current liability account, called Sales Tax 
Payable, that keeps track of the sales tax you collect in your business. 

 
Notes 
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Creating Estimates 
 
If you provide any type of estimate or bid—even a verbal quote—there are many reasons to 
use estimates in QuickBooks. 
 

 Prepare professional-looking itemized estimates, bids, quotes, or proposals for your 
customers.  

 Create an invoice from the estimate with just one click. QuickBooks then creates an 
invoice using information from your estimate. 

 Create reports that compare your estimated costs and revenue against your actual 
costs and revenue. 

 Compare your actual costs against what you estimated.  
 Track which estimates are still active and easily update each estimate as you continue 

to negotiate with your customers. 
 
To create estimates for your business: 
 

1. On the “Do you want to create estimates in QuickBooks?” window, click Yes. 

2. Click Next. 

 
Notes 
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Using sales orders 
If your customers sometimes place orders for items that you don't have in stock or are not yet 
ready to invoice for, use a sales order in QuickBooks to track the sale. 

 
To set up sales orders: 
 

3. On the “Tracking customer orders in QuickBooks” window, click Yes. 

4. Click Next. 

 
Notes 
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Using Sales Receipts 
 
If your customers pay you in full at the time of purchase, use a sales receipt in QuickBooks 
to track the sale. 
 
You can use a sales receipt to: 

 Track each sale 
 Calculate sales tax 
 Print a sales receipt 
 Create a summary of sales income and sales tax owed 
 Summarize daily or weekly sales on a sales receipt 

 
To set up sales receipts: 
 

1. On the “Using sales receipts in QuickBooks window, click No. 

2. Click Next. 

 
Notes 
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Choosing Remaining Preferences 
 
The next series of windows ask “yes or no” questions that enable or disable different 
QuickBooks features, based on your company needs. Simply click Yes or No, then click 
Next to move forward in the Interview. For Lockhart Design, complete the preferences by 
giving the following responses: 
 
 

For this item...  Select... 
Billing statements  No 
Progress invoicing  Yes 
Bill tracking  Yes 
Do you print checks? I print checks. 
Inventory  No 
Credit and debit cards I accept credit cards and debit cards 
Track time  Yes 
Employees  No 

 
 
You can always change preference settings later, after the EasyStep Interview. From the Edit 
menu, choose Preferences, and then select the preference type in the left panel. 
 

Notes 
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Choosing a Start Date 
 
The start date is the date for which you give QuickBooks a financial snapshot of your 
company assets and liabilities. 
 
To choose a start date: 
 

1. On the “Using Accounts in QuickBooks” window, click Next. 

 

 
 

2. On the “Select a date to start tracking your finances” window, select “Use today’s 
date or the first day of the quarter or month.” 

3. Enter 12/31/2007 and then click Next. 

 
Notes 
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Entering Opening Balances 
 
The balance sheet accounts in the QuickBooks chart of accounts start with an opening 
balance of zero. Before you begin working in QuickBooks, you need to enter an opening 
balance for each balance sheet account as of your start date. 
 
To enter the checking account opening balance: 
 

1. On the “Add your bank account” window, make sure Yes is selected and then click 
Next. 

2. Type Checking as the name of the account. 

3. For “When did you open this bank account?,” click Before. 

 

 
 

4. Click Next. 

 
Notes 
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Entering Opening Balances 
 

1. For Statement Ending Date, type 12/28/2007. 

2. In the Statement Ending Balance field, type 8359.00. 

 

 
 

3. Click Next. 

4. When QuickBooks asks if you want to add another bank account, click No. Then 
click Next. 

 

Notes 
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Reviewing the Chart of Accounts 
 
The chart of accounts is made up of five types of accounts common to all businesses—the 
income and expense accounts used by the Profit and Loss Statement, and the asset, liability, 
and equity accounts used by the Balance Sheet. Each time you enter a transaction, 
QuickBooks will prompt you to categorize it into one of these five types of accounts. 
 
Because you chose an industry from the list earlier in the Interview, QuickBooks has already 
created income and expense accounts for your company.  
 
To review the chart of accounts: 
 

1. In the “Review income and expense accounts” window, scroll through the preset 
accounts to get an idea of what is included. 

2. Click Next. 

 

Notes 
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Finishing the Interview 
 

 To leave the EasyStep Interview and save your changes, click Finish. 
 
After you have completed the EasyStep Interview, Intuit recommends that you not use the 
Interview to make changes to your company file. 
 
Use the information in the help options described later to help you make changes and 
adjustments to your company file. 
 
Next, you’ll complete the company file setup. 
 

Notes 
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Completing Company File Setup 
 
After you have created your company file using the EasyStep Interview, you can begin using 
QuickBooks to run your business.  
 
However, there are some additional tasks you might need do to make sure the company file is 
properly set up and that the data is complete. 
 
QuickBooks is based on four key concepts: 
 

  Customers & jobs 
  Vendors 
  Accounts 
  Items 

 

Notes 
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Adding Customers 
 
In order to bill customers with QuickBooks, you need to add your customers. 
Note: You can also add customers and vendors as you perform everyday tasks. For example, 
if you enter the name of a new customer when filling out an invoice, QuickBooks will 
prompt you to enter information about this customer. You can choose from two quick setup 
options: Quick Add and Set Up. Quick Add adds the name to the list and you add details 
later. Set Up lets you enter the details right away. 
 
To add a customer: 
 

1. First, close the QuickBooks Learning Center, if it is open. 

2. Click Customer Center in the navigation bar. 

3. Click the New Customer & Job menu button, and then choose New Customer. 

4. In the Customer Name field, enter the name of the customer as you'd like it to appear 
on your Customers & Jobs list. For this exercise, type Smith, Lee, and then press 
Tab. 

5. Press Tab in the Opening Balance field to leave this field blank. 

For now, leave this field blank. Lockhart Design is planning to set up one or more 
jobs for this customer. QuickBooks will calculate and track the overall balance for 
this customer from the balances you enter for the individual jobs. 

 
6. In Address Info tab, click in the First Name field and type Lee. 

7. Press Tab and type M. as the middle initial and in the Last Name field, type Smith. 

 

Notes 
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Adding Customers 
 

8. Press Tab to go to the Address field, and then press Enter after Lee M. Smith. 

9. Type 43 Hampshire Blvd and press Enter. 

10. Type East Bayshore, CA 94327. 

11. Click the Copy button to copy the address to the Ship To field. Click OK in the Add 
to Ship To Address Information window. 

 

 
 

12. Click OK to add this customer. 

 

Notes 
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Adding a Job 
 
You do not need to add jobs to the Customers & Jobs list if your company never does more 
than one job or project per customer. Jobs in QuickBooks are optional. If you often perform 
multiple jobs for the same customer, you can use jobs in QuickBooks to track the activity for 
each job separately. 
 
Lockhart Design wants to track jobs for Lee Smith. 
 
To add a job for a customer: 
 

1. In the Customers & Jobs list, right-click Smith, Lee and choose Add Job. 

2. In the Job Name field, type Patio, and press Tab. 

3. In the Opening Balance field, type 862 and press Tab. 

4. Enter 12/31/2006 in the As Of field to indicate that this was the balance outstanding 
for this job as of the QuickBooks start date. 

 

Notes 
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Adding a Job 
 

5. Click the Job Info tab and choose In Progress from the Job Status drop-down list. 

Job status information is for your records—it gives you a way to keep track of each 
job.  
 

6. For the Start Date, type 12/15/06 and press Tab. 

7. In the Projected End date, type 3/15/07 and press Tab. 

8. Click OK. 

9. If you see a message about a past or future transaction, click Yes to save the 
transaction. 

The job now appears under Smith, Lee in the Customers & Jobs list. 
 

 
 

10. Close the Customer Center. 

Notes 
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Adding Vendors 
 
In order to pay your bills with QuickBooks, you need to add your vendors. Nearly everyone 
you pay, other than employees, are vendors. 
 
To add a vendor: 
 

1. Click Vendor Center in the navigation bar. 

2. Click New Vendor in the button bar. 

3. In the Vendor Name field, enter the name of the vendor as you'd like it to appear on 
your Vendor list. For this exercise, type Fay, Maureen Lynn, CPA, and then press 
Tab. 

4. In the Opening Balance field, type 350, which is the amount you owed this vendor as 
of the start date. Press Tab. 

5. In the As Of field, enter 12/31/06.  

6. In Address Info tab, click in the First Name field and type Maureen. 

7. Press tab and type L. as the middle initial and in the Last Name field, type Fay. 

8. Press Tab to go to the Address field, and then press Enter after Maureen L. Fay. 

9. Type 200 Royal Rd. and press Enter. 

10. Type Bayshore, CA 94326. 

11. Click in the “Print on Checks As” field, and type Maureen Fay. 

12. Click OK to add this vendor. 

13. Close the Vendor Center. 

 

Notes 
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Setting Up Additional Accounts 
 
During the EasyStep Interview, you added one checking account for Lockhart Design.  
 
There are two basic types of accounts:  
 

 Balance sheet accounts, such as savings or checking  
 
 Accounts used to group transactions for reporting purposes, such as income and 

expense accounts  
 
Income and expense accounts track the sources of your income and the purpose of each 
expense. When you record transactions, you usually assign the amount of the transaction to 
one or more income or expense accounts. 
 

Notes 

Lesson 2: Setting Up  27 



Setting Up Additional Accounts 
 
In the EasyStep Interview, you selected “Retail Shop or Online Commerce” as the industry 
for Lockhart Design. QuickBooks created a chart of accounts based on the retail industry. 
However, Margaret Lockhart also receives income from design consulting. She needs to 
modify the chart of accounts to add an income account for consulting. 
 
 

Notes 
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Setting Up Additional Accounts 
 
You may need to add one or more of the following accounts: 
 

 Income accounts to track new sources of income 
 
 Expense accounts to track new types of expenses 

 
 Bank accounts when you open new checking, savings, or money market accounts at 

your bank 
 
 Credit card accounts when you acquire new credit cards 

 
 Other kinds of balance sheet accounts to track specific assets, liabilities, or equity 

 
A complete list of your business’ accounts and their balances appear in the chart of accounts. 
You use a chart of accounts to track how much money your company has, how much money 
it owes, how much money is coming in, and how much is going out. 
 
For Lockhart Design, you’ll add an income account for her consulting income. 
 

Notes 
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Setting Up Additional Accounts 
 
To add an income account: 
 

1. From the Lists menu, choose Chart of Accounts. 

2. Click the Account menu button and choose New. 

3. In the Add New Account window, choose Income and then click Continue. 

4. Click in the Account Name field, and type Consulting. 

5. From the Tax Line Mapping drop-down list, choose Sch C: Other business income. 

 

 
 

6. Click Save & Close, and then close the Chart of Accounts. 

 

Notes 
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Adding Items 
 
In QuickBooks, an item is anything that your company buys, sells, or resells in the course 
of business, such as products, shipping and handling charges, discounts, and sales tax (if 
applicable). You can think of an item as something that shows up as a line on an invoice 
or other sales form. 
 
QuickBooks provides several different types of items. Some—such as the service item or 
the inventory part item—help you record the services and products your business sells. 
Others—such as the subtotal item or discount item—are used to perform calculations on 
the amounts in a sale. 
 
For Lockhart Design, you’ll set up a service item for billing the time used for initial 
consultation for a design project. You’ll assign it to the new Consulting income account. 

 
 

Notes 
 

Lesson 2: Setting Up  31 



Adding Items 
 
To add an item: 
 

1. From the Lists menu, choose Item List. 

 

 
 

2. Click the Item menu button, and choose New. 

3. In the New Item window, choose Service from the Type drop-down list. 

4. Click in the Item Name/Number field and type Initial Design Consultation. 

5. In the Description field, type Initial design consulting. 

 

Notes 
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Adding Items 
 

6. Click in the Rate field, and type 40. 

7. In the Tax Code field, choose Non-Taxable Sales from the drop-down list. 

8. In the New Item window, choose Service from the Type drop-down list. 

9. In the Account field, choose Consulting as the income account. 

 

 
 

10. Click OK to add the new item to the Item List. 

11. Close the Item List.  

 

Notes 
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Entering Historical Transactions 
 
If your QuickBooks start date is before today’s date, you need to enter past transactions so 
that you have complete financial records from the start date forward. It is important to enter 
historical transactions in this order: 
 

1. All sales (sales receipts, invoices, or statement charges) 
 

2. Customer payments received for outstanding invoices after the start date 
 

3. Bills received since the start date 
 

4. Bills paid since the start date 
 

5. Deposits made to any of the accounts since the start date 
 

6. Any other checks written (other than bills) since the start date 
 

Notes 
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Getting Help While Using QuickBooks 
 
QuickBooks provides extensive help in various formats. When you have questions, 
QuickBooks provides: 
 

• Onscreen Help to provide conceptual information and step-by-step instructions. 
• Tutorials on key tasks. These are available by choosing Learning Center Tutorials 

from the Help menu. 
 
The onscreen Help provides several different types of information: 
 

• Conceptual explanations of how to apply QuickBooks to your particular business 
situation. 

• Step-by-step instructions. 
• A search engine that provides you with a list of topics related to the word or phrase 

you enter. 
• Information relevant to the task you are currently performing. 

 

Notes 
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Getting Help While Using QuickBooks 
 
To find a topic in onscreen Help: 
 

1. From the Help menu, choose QuickBooks Help. 

2. Click the Search tab. 

3. Type customers and click the arrow button. 

QuickBooks Help displays a list of topics related to customers. 
 

4. Click Add a customer. 

QuickBooks displays the topic in the screen lower portion of the help window. 
 

 
 

5. Close the Help window. 

 

Notes 
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Lesson 2: Setting Up QuickBooks 
 
Review questions 
 
1. During the EasyStep Interview, QuickBooks creates income and expense accounts based 

on your company’s ____________________  
 
2. When setting up a company file in QuickBooks, what does the Start Date signify? 
 

a The date the business was created 
b The first date of the company’s fiscal year 
c The date the company purchased QuickBooks 
d The date from which you will be entering transactions in QuickBooks 

 
3. When setting up a company file in QuickBooks at the beginning of a fiscal period, you 

would normally select which of the following as the start date? 
 

a The first day of the current fiscal period 
b The last day of the previous fiscal period 

 
4. True or false: Once you have set up the chart of accounts, you cannot add, delete, or 

modify accounts. 
 

a True 
b False 

 
5. Before working in QuickBooks, you need to enter an ______________ ____________ 

for each account. 
 
6. True or false: Choosing a company organization associates a tax form with your business 

in the QuickBooks file. 
 

a True 
b False 

 
7. In QuickBooks, linking income and expense accounts with tax lines does which of the 

following? 
 

a Helps keep your company profitable 
b Helps in preparing income taxes 
c Helps keep track of sales taxes you owe 
d Both B and C 
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Review activities 
 
 

1. Turn on class tracking in the company file you created in this lesson. 
 

2. Display a Help topic on using class tracking. Explain when and why you might want 
to track classes. 
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Answers to review questions 
 
1. During the EasyStep Interview, QuickBooks creates income and expense accounts based 

on your company’s industry. 
 
2. When setting up a company file in QuickBooks, what does the Start Date signify? 
 

a The date the business was created 
b The first date of the company’s fiscal year 
c The date the company purchased QuickBooks 

 Dd The date from which you will be entering transactions in QuickBooks 
 
3. When setting up a company file in QuickBooks at the beginning of a fiscal period, you 

would normally select which of the following as the start date? 
 

a The first day of the current fiscal period 
 Db The last day of the previous fiscal period 
 
4. True or false: Once you have set up the chart of accounts, you cannot add, delete, or 

modify accounts. 
a True 

 D b False 
 
5. Before working in QuickBooks, you need to enter an opening balance for each account. 
 
6. True or false: Choosing a company organization associates a tax form with your business 

in the QuickBooks file. 
 
D a True 

b False 
 
7. In QuickBooks, linking income and expense accounts with tax lines does which of the 

following? 
 

a Helps keep your company profitable 
 Db Helps in preparing income taxes 

c Helps keep track of sales taxes you owe 
d Both B and C 
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